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COMMUNICATION SKILLS  

Effective communication skills are a critical element in your career and 
personal life. We must use a variety of communication techniques both to 
understand and to be understood 

 
WHAT IS COMMUNICATION 

It is the art of transmitting information, ideas and attitudes from one person 
to another. Communication is the process of meaningful interaction among 
human beings. 

 
DEFINITION OF COMMUNICATION 

Communication is the transfer of information from one person to another. It 

is a way of connecting with others by transmitting ideas, facts, thoughts, 

feelings and values.Three aspects of communication: Messages, Ideas, 

Information.  

COMMUNICATION-MEANING 

Communication is a dynamic process through we convey a thought or 

feeling to someone else. How it will be perceived depends on a set of 

events and stimuli that the person has been exposed to. In fact, how you say 

what you say plays an important role in communication. 

 
WHY COMMUNICATE? 

We usually do communicate to express our emotions, to achieve joint 

understanding and to develop relationships with other persons. 

Communication is be used also to pass and obtain information, or make 

decisions and reach agreements.  

 
 

 



 

WHY IS COMMUNICATION IMPORTANT? 

Communication is essential to help build confidence, but also it helps us 

build respect in business and in our social lives. It is very useful to help us 

make friends, develop distinct personalities and it can be considered as a 

way for us to reveal our abilities to others. 

 
COMMUNICATION GOALS 

The main goals of communication focus on relationships: it aims to change 

behavior of people, to get action, to ensure understanding, to persuade 

other people and, more important, to receive and give information. 

 
ESSENTIALS OF GOOD COMMUNICATION 

The main essential of communication is, out of any doubts, knowledge: you 

have to know what you are communicating, and be spontaneous in 

conversation. Another important step is organizing your thoughts and then 

participating in discussions. The body language and being a good listener 

are important, too.   

 
LEVELS OF COMMUNICATION 

The communication consists in three different levels: verbal, no-verbal and 

symbolic. The first one is composed by intra verbal communication (like 

the intonation of words and sounds) and extra verbal (semantics); the 

second one includes gestures, postures, movement.  

 
BARRIERS TO COMMUNICATION FOR THE COMMUNICATOR 

There are many factors and attitudes to avoid in order to communicate a 

message in the best way. First of all, the refusal to say things differently, to 

relate to other people and to learn new approaches con be view as 

problems. Lack of confidence and enthusiasm can be barriers, too. Other 

factor that can convert to obstacle if used wrong, are the quality of the 

voice.   



 
 

WHAT TO DO WHWN SPEAKING, WRITNG, LISTENING  

While speaking, you have to take initiative, to be polite, pleasant (with 
smiles and making jokes), clear and concise, controlling your tone, accent, 
pronunciation and using emphasis. You should cite negative opinions 
honestly, but in a positive manner, seeking all kind of feedback.While 
writing, you have to plan and organize what you want to say in your 
letter/report; then, reread the letter when you have finished and finally, 
check spelling &punctuation, then send. Use simple language (avoid 
ambiguous words). While listening, you have to avoid distractions, do not 
interrupt unnecessarily and be active, showing all the interest as you can. 
Remember to paraphrase what you’ve heard. 

 
EXTERNAL BARRIERS TO COMMUNICATION 

There are three external factors that influence communication: 
ENVIRONMENT (the venue, the effect of noise, the temperature of the 
place where the communication is carried out); OTHER PEOPLE, referring 
to its status and social condition; and TIME.  
 

CONCLUSIONS 

Concluding, we can say that a good communication has to be free of stress, 

clear, reciprocal and involve active listening. Communication reflects the 

accountability of the speaker and the listener, because both speaker and 

listener receive feedback and respond to this feedback. 

 
 

 



Leadership 

Leadership has been described as "a process of social influence in which one person can enlist 

the aid and support of others in the accomplishment of a common task". Some believe that a 

leader is simply somebody whom people follow, or somebody who guides or directs others, 

while others define leadership as "organizing a group of people to achieve a common goal". 

 

A leadership style is a leader's style of providing direction, implementing plans, and motivating 

people, which results from the leader’s philosophy, personality, and experience. Rhetoric 

specialists such as Robert Hariman and Philippe-Joseph Salazar have also developed models for 

understanding leadership.  

Different situations call for different leadership styles. In an emergency when there is little time 

to reach an agreement and where a designated authority has significantly more experience or 

expertise than the rest of the team, an autocratic leadership style may be most effective; 

however, in a highly motivated and aligned team with a homogeneous level of expertise, a more 

democratic or laissez-faire style may be more effective. The style adopted should be the one that 

most effectively achieves the objectives of the group while balancing the interests of its 

individual members. 

 

Engagement 

In early leadership literature, a leadership style consisting of engagement is mentioned and 

emphasized various times. For example, Stephen Cohen describes engagement as one of four 

key leadership practices for tough times saying, "what these initiatives do for the organization is 

engage both leaders and employees in understanding the existing conditions and how they can 

collectively assist in addressing them. Reaching out to employees during difficult times to better 

understand their concerns and interests by openly and honestly conveying the impact of the 

downturn on them and their organizations can provide a solid foundation for not only engaging 

them but retaining them when things do turn around.” 



Autocratic or authoritarian 

Under the autocratic leadership style, all decision-making power rests with the leader (such as a 

dictator).  

Leaders do not entertain any suggestions or initiatives from subordinates. The autocratic 

management has been successful because it provides strong motivation to the manager. Because 

only one person decides for the whole group, autocratic leadership allows for quick decision-

making. The autocratic leader keeps each decision to him/herself until he/she feels it needs to be 

shared with the rest of the group. 

 

Participative or democratic 

The democratic leadership style consists of the leader sharing the decision-making abilities with 

group members by promoting their interests and by practicing social equality. This has also 

been called shared leadership. 

 

Laissez-faire or free-rein 

A person may be in a leadership position without providing leadership, leaving the group to 

fend for itself. Subordinates are given a free hand in deciding their own policies and methods. 

The subordinates are motivated to be creative and innovative. 

 

Narcissistic 

Narcissistic leadership is a common leadership style in which the leader is only interested in 

him/herself. Their priority is themselves - at the expense of their people/group members. This 

leader exhibits the characteristics of a narcissist: arrogance, dominance and hostility. The level 

of narcissism can be anywhere from healthy to destructive. To critics, "narcissistic leadership 

(most often destructive) is driven by unyielding arrogance, self-absorption, and a personal 

egotistic need for power and admiration."  



 

Toxic 

A toxic leader is someone who has responsibility over a group of people or an organization and 

abuses the leader–follower relationship. A toxic leader leaves the group or organization worse 

off than it was when he/she joined it.  

 

Task-oriented and relationship-oriented 

Task-oriented leadership is a style in which the leader is focused on the tasks that need to be 

completed in order to meet a certain production goal. Task-oriented leaders are generally more 

concerned with producing a step-by-step solution for a given problem or goal, creating 

deadlines and strictly making sure these deadlines are met to achieve the target outcome.  

Relationship-oriented leadership is a contrasting style in which the leader is more focused on 

the relationships amongst the group and is generally more concerned with the overall well-being 

and satisfaction of group members. Relationship-oriented leaders emphasize communication 

within the group, show trust and confidence in group members, and show appreciation for 

completed work. 

Task-oriented leaders are typically less concerned with catering to group members and more 

concerned with finding a solution to meet a certain production goal. For this reason, they 

typically are able to make sure that deadlines are met, yet their group members' well-being may 

suffer. Relationship-oriented leaders are focused on developing the team and the relationships 

within the team. The benefit of having this kind of environment is that team members are more 

motivated and feel supported; however, the emphasis on relations as opposed to getting a job 

done might make productivity suffer. 

 

 

 

 

 

 



 

The Meaning of Leadership 

Leadership is the social process of influencing the behavior of others without posing any threats 

of violence. It is a process of influencing the thoughts, attitudes and behaviors of others by 

setting a direction that helps them visualize what they can hope to achieve or what lies ahead for 

them. It’s the capability of getting other people to do something significant through harnessing 

their efforts and abilities jointly. 

Leadership in a very ordinary sense refers to creating a group of followers whom another 

individual leads. Merely accompanying a group of people isn’t leadership unless the person 

actually is choosing and showing a direction to the followers. Without followers, a leader isn’t a 

leader, even if he/she has the desired qualities or nature of a leader. 

 

 

The Essence of Leadership in Business 

The nature of business leadership is both a complex and compelling phenomenon. Many 

discussions of leadership confuse personality, important objectives, formal position and specific 

behaviors with acts of leadership. Leadership may involve certain characteristics, but it is not 

confined to these characteristics; rather, it’s all about influencing others in a substantial way. 

No matter what the setting is (a business, a government, an educational institution, or an athletic 

team), most people would agree that having a good leader is desirable. A good leader is like a 

good physician. Just as the physician must identify the patient’s disease accurately to ensure the 

effectiveness of the prescribed treatment, the business leader must also be able to diagnose 

problems, values and voices while finding effective solutions. 

A leader is not satisfied with average and he/she strives to exceed expectations by carrying a 

sense of mission, motivating, learning and inspiring new ways of thinking. This is known as 

transformational leadership. This style is the most updated and diversified technique in the field 

of leadership theory and it helps boost workforce competency and performance.  

 

Leadership and Management in Business  



True leadership in business is a subtle quality, and thus we often confuse management duties 

with leadership. Management and leadership are related, but they are not the same. You can be a 

manager or a leader; you can also be both or neither. The biggest difference between managers 

and leaders lies in the way they motivate others. When executing plans as a manager, you focus 

on supervising results, comparing them with goals and correcting deviations. In contrast, as a 

leader you focus on energizing people to overcome hurdles in reaching goals. Effective leaders 

address pressing issues such as influence, power, dependence, and policies for change. 

Power, achievement and affiliation shape the basic human needs and are acquired over time, 

eventually resulting in legitimate reward and control in a business setting. If as a leader you 

have a high need for institutional power rather than personal power, you may be more effective. 

Personal power can be transformed into leadership abilities through the adoption of different 

approaches to leadership and adjusting your perspective of what the meaning of “power” is. 

 

When trying to expand and embrace the idea of being a leader ourselves, we must remember 

that leadership encompasses the field of a widely discussed phenomenon in the business world. 

One is not born a leader and one cannot become a leader overnight; rather, being a leader is a 

continuous process that requires constant learning and adaptation. The growing influence of 

global culture and workforce diversity makes the task of being an effective leader that much 

more challenging. Simply put, leadership is all about energizing people toward a specific goal. 

The theoretical and practical knowledge regarding leadership can help you implement perfect 

leadership strategies in business development, which you can then embrace using the required 

adaptability and emotional intelligence to succeed as a business leader.  

 

The four fundamental factors of production are land, labour, capital and entrepreneurship. The 

final factor is perhaps the most important in terms of organization and efficiency, and it requires 

great business leadership. Leadership acts as the catalyst that makes all other elements work 

together; without leadership, all other business resources lie dormant. Savvy business leaders 

are in tune with the needs and issues of their subordinates, and keep up to date on new 

developments in leadership theory and methodology to maximize their effectiveness. 

 

Significance 

A leaderless organization is like an army without generals. People in the labor force need the 

leadership of skilled and experienced individuals to provide guidance and a single direction for 



all employees to follow. Leaders are invaluable when it comes to formulating and 

communicating new strategic directions, as well as communicating with and motivating 

employees to increase dedication to organizational goals. 

Functions 

Business leaders serve a range of important functions in their organizations. Leaders are 

responsible for training employees to perform their tasks effectively, as well as supervising the 

actual completion of those tasks on a regular basis. Leaders must inspire employees to get 

excited about the company and their work, pushing them to excel and helping them along the 

way. Leaders are also tasked with protecting the employees from internal and external threats, 

ranging from political backstabbing to physical security. 

Types 

Different leaders employ different leadership styles. Leaders with a command and control style 

formulate ideas on their own and dictate actions to their employees. Collaborative leaders come 

up with ideas with the assistance of employees from all levels of the organization, leveraging 

employees' creativity to boost company performance. Facilitative leaders delegate almost all 

productive tasks to subordinates, and focus on providing their employees with everything they 

need to excel in their jobs. Business owners' leadership styles are extremely important in 

crafting company culture. 

Delegation 

Delegation, the act of assigning productive tasks to subordinates, is vital to success as a business 

leader. More important than delegating individual tasks, however, is the ability to delegate 

authority and develop leaders for the future. Assigning tasks is a basic management activity; 

assigning responsibility for figuring out how to accomplish objectives takes management to the 

next level. It is important to develop leaders to partner with you in the future as your business 

grows; this can greatly increase employee satisfaction and loyalty as well. 

Considerations 

Leaders and leadership styles may need to be changed to suit specific situations. A new CEO in 

an established company, for example, may benefit from altering his leadership style to be more 

in line with the culture of his new company. Top executives themselves may need to be 

switched out from time to time if a company's performance establishes a pattern of decline. 
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THE CONCEPT OF MARKETING 
 
Marketing can be defined as the process of providing movement of products and 
services by using appropriate deployment, an affordable price and convenient 
communication (promotion) to satisfy the needs of the consumers. 
 

THE FEATURES OF MARKETING 
 
The fundamental features of marketing can be considered to be the following: 
 
Versatility of consumers:the different types of consumers, as well as their needs, 
have to be identified. The consumer is the focal point of the marketing analysis. 
 
Coordination of activities: marketing activities have to be coordinated with other 
business functions (manufacturing, finance, personnel, engineering, management, 
etc.) 
 
Openness to change: the constantly changing needs of the people force 
entrepreneurs to make changes 
 
Definition of a goal: a broadunderstanding of your presence in a particular market 
is needed to take advantage of new developments and adapt to the ever-changing 
conditions of the market 
 
Profit seeking:long-term profits rather than short-term profits should be taken into 
consideration. 
 

UNDERSTANDING THE DEVELOPMENT PROCESS OF MARKETING 
 
Production Orientation:This approach follows the motto: ”what is produced will 
be sold”. Itis product/service oriented, and its main goal is to identify the properties 
and characteristic of a particular product or service in order to improve production 
efficiency and sell it. It is typical of situations of under-capacity (in which the 
demand is way higher than the production). 
 
Product Orientation:It’s the oldest marketing philosophy, and a significant 
example of it is represented by the production of the Ford T in the United States, at 
the beginning of the century. 
It is based on the belief that consumers will buy the products that offer the most in 
quality, which is the reason why the quality of a product has to be continuously 
improved. It can be an effective but also dangerous technique, since it is possible to 
forget the real needs of the consumers by being too focused on quality or, in other 
words, to miss the “big picture” (this phenomenon is defined as Marketing Myopia). 
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Selling Orientation: The main idea of this approach is that consumers won’t buy if 
they are not pushed. It is usually encountered in situations of overcapacity (when 
the production is way higher that the demand). This was the dominant philosophy 
during the 20th century, and it is still used for unsought goods (i.e. goods that buyers 
do not normally think of buying, like encyclopedias). 
This approach considers short-term plans, and higher sales are expected with 
higher profits. 
 
Consumer Orientation (a.k.a. Market Orientation): it’s based on the satisfaction 
of the needs and wants of the consumers. To follow this philosophy, a company has 
to be able to see its business with the eyes of the customer and has to understand 
the importance of customer satisfaction. It is fundamental, from this point of view, 
to develop customer relations. 
 
Contemporary marketing approach: in the 1950s, business managers noticed the 
importance of understanding the consumers, their specific needs and perceptions 
about the products or services they provided.This philosophy establishes that a 
company’s goal is not only to satisfy the desires the consumers, but also to take care 
of their long-term interests. A wider concept of marketing is being considered here, 
recognizing that some products that consumers might buy are not in their best 
interest or, more generally, in society’s best interest. 
Sustainable growth policies or the commitment with environmental and social 
causes, among others, are part of a contemporary marketing approach. 
Modern marketing approaches take into consideration long-term results: making 
money is not their main goal, it is rather a consequence of the deeper understanding 
of long-term marketing strategies. 
 
The key concepts of classical and contemporary marketing approaches are listed in 
Table -1. 
 

Métodos de marketing clásicos  Métodos de marketing contemporáneos  
Mass marketing Personal marketing 
Product oriented Consumer oriented 

Goal: earn money Result: earn money 
Short term view Long term view 

One way message Versatile message 

Table 1. – Comparison between classic and contemporary  marketing methods 
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MARKETING VARIABLES 
 
The concept of “Marketing diversity” emphasizes that the main focus of marketing 
today should be to create effective communication methods and a communication 
mix appropriate to each of the diverse groups active in the market. 
 
Business activities do not operate in a vacuum: they are surrounded by 
environmental variables, which can affect them either positively or negatively. 
These marketing variables are categorized in two groups: 
 

1. Controllable variables (Marketing Mix) 
2. Uncontrollable Variables (also called environmental variables, they depend on 

the external marketing environment) 
 
Marketing mix 
 
A company presents a number of proposals to the costumers that can be divided 
into four categories: product, price, distribution and promotion. These constitute a 
marketing effort to improve customer satisfaction. They affect each other as well as 
other business activities, and are also influenced by environmental variables. 
 
Product:a product can be defined as an item that tries to satisfy what a consumer 
demands. It is offered as a tangible good (that have an independent physical 
existence) or an intangible service. 
 
Price: it refers to a product’s measured value in a particular currency, which is 
equivalent to the amount a customer pays for the product. Price plays a fundamental 
role in the costumer’s decision of purchasing or not a determined product or service 
as well as in the company’s profit.  Issues such as consumer demand, cost, rival 
businesses, etc. are taken into consideration when determining a price. 
 
Distribution: it refers to the activities that provide a product at a convenient 
location for consumers to access. 
These activities include the participation of intermediary organizations, called 
distribution channels, and the physical delivery of a product.  
 
Promotion: it refers to all the methods of communication that may be used to 
provide information to potential consumers about a particular product or service, 
and it’s based on communication techniques. 
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Uncontrolled Variables (environmental variables) 
 
In addition to the Marketing mix elements, some other variables have a decisive 
influence on the market and cannot be controlled by entrepreneurs. These are called 
external and environmental variables.  
Entrepreneurs should constantly monitor external and environmental variables and 
adjust their marketing activities accordingly. 
 
Social and cultural: the cultural opinion, life style and life quality of the consumers 
will affect marketing decisions. 
 
Legal and political variables: law or policy changes can affect marketing activities, 
and a frequently changing legal and political environment will complicate decision-
making in the market. 
 
Technological variables:technological innovation and breakthroughs will affect 
marketing by developing new working techniques and marketing opportunities. 
 

Legal and political variables 

Social and 
cultural 

variables 

Technologic
al variables 

Economic variables 

Product Distribution 

Price Promotion 

Consumer 
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Economic variables: a higher or lower income will directly affect the marketing 
activities of a company. 
 
 

MARKETING PLAN 
 

One of the most difficult jobs for the entrepreneur is to be able to predict the future, 
to anticipate mayor changes in the market and to identify the preferences of the 
consumers. To take on these challenges, it is convenient to develop a marketing 
plan. 
 
A marketing plan process comprehends the steps specified in Table 3. 
 
Analysis of the situation Where are we? 
Marketing goals and strategies What do we want to accomplish? How do 

we accomplish our goals? 
Marketing action programs What should we do? 
Implementation of the plan How, when and with whom should we do 

it?  
Assessment, evaluation and correction How do we judge our effort? How can we 

quantify the development of our 
actvity?What changes should we do? 

Table 3. – The marketing plan process 
 
The marketing plan process requires a good deal of thinking and creativity in order 
to identify the entrepreneur’s goals and to work on ways to achieve them. In this 
process, the questions: “Where are we?” “What do we want to accomplish?” 
and“How do we accomplish our goals?” are fundamental.  
A typical marketing plan contains at least three of the following elements: analysis 
of the situation, planning purposes, strategy and plan of action. 
 
Analysis of the situation (SWOT) 
 
It’s an analysis technique that evaluates the company’s internal and external 
environment. The company can find adjustment opportunities based on the 
information of its own internal state, market structure and analysis of the 
competition. In this process, both the “current situation” and the “future situation” 
are analyzed. 
 

 Strengths (identification of the most solid qualities of the company) 
 

 Weaknesses (identification of the weak points of the company) 
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 Opportunities (identification of emerging opportunities for the 
company) 

 
 Threats (identification of the threats and potential dangers for the 

company) 
 
SWOT analysis of the external environment variables that affect the business is 
fundamental to identify the limits of the company and its employees.  
 
Opportunities and threats: opportunities come from poorly delivered services or 
changes in the market conditions and needs. Therefore, changes in the external 
market generating possibilities, both in the present and the future, will be the 
source of the analysis. From this perspective, opportunities can arise from: 
 

 The variation of the conditions of the market (legal developments, 
competitors leaving the market, market growth, etc.) 

 From poorly delivered services that do not fully satisfy the consumers needs 
 
Strengths and weaknesses: After evaluating the opportunities and threats 
determined by the external environment, the company’s strengths and weaknesses 
have to be identified. This analysis involves the performance study of functional 
areas such as manufacturing, planning, finance, management, etc. All activities are 
evaluated one by one. Thus, the resources and the ability to compete in a particular 
market of the company are measured.  
A practical way of carrying out this analysis is to organize strengths and weaknesses 
in a list.  
The strengths of a company can be defined as the features that provide an asset to 
one or more of the following goals: 
 
-To have a better product 
-To be consumer focused 
-To have a strong brand 
-To have a more advanced technology 
-To have a better customer service, etc. 
 
 
Production and sale of fabric bags and string bags – SWOT analysis 
 
A group of 15 women working at home decides to sell their hand-man string bags.  
 
STRENGTHS 

1. Manufactured products are easy to 
transport and store 

WEAKNESSES 
 

1. Failure to produce according to the 
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2. The product draws the attention of 

people, institutions and 
organizations 

 
3. Durable, long lasting and easy to 

clean product 
 

4. Diversity of the product 
 

5. No need for big production of 
tools 

 
6. Almost everyone can be identified 

as a target group 

tastes of the consumer (e.g. color 
combination) 
 

2. Lack of regular sales and profits 
 

3. Lack of experience ofemployees in 
marketing techniques 
 

4. Manufacturer and supplier 
inability to renew themselves 

 
5. Fabrication errors (symmetry, 

planting bugs) 
 

6. employees can’t effectively use the 
internet 

OPPORTUNITIES 
 

1. Identification of the tastes of the 
consumer based on popular images 
and symbols, sport teams colors 
and logos, etc. 
 

2. Souvenirs 
 

3. Sell in a variety of places (fairs, 
etc.) 

 
4. Use the internet as a tool to sell 

products around the world 
 

5. Production can target customers 
according to their age, gender, 
cultural background, etc. 

 
6. To be potential customers of large 

companies that want to promote 
environmental awareness 

THREATS 
 

1. Sudden increments in the prices of 
raw material 
 

2. Violation of consumer rights (lack 
of product warranty) 

 
3. Potential accidents to the 15 

employees with sewing machines. 
 

4. Inability to obtain the expected 
profit due to inefficient advertising 

 
5. Difficulty to change shoppers 

habits 
 

6. Low level of environmental 
awareness of the community 

 
 
Strategic goal: 
 

 To increase the knowledge and selling skills of individuals who work in 
production and sells 
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 To improve use of the internet 
 To improve production strategies 

 
Strategic goal 1: to improve the knowledge and skills in marketing techniques of 
the 15 employees. 
 
Strategic goal 2: to improve the knowledge and skills in the use ofthe Internet of 
the 15 employees. 
 
Strategic goal 3: to teach knitting and sewing to the 15 employees. 
 
Goals and Strategic Planning 
 
Goals are defined as the desired results from our actions. Goals should be based on 
the strengths of a company, while trying to minimize weaknesses. 
 
The goals of a marking plan should have the following features: 
 

 They should be specific and they should focus only on one issue 
 They should include a precise period of time 
 They should be realistic, without being too simple nor too ambitious 
 They should be clear and understandable 

 
The types of goals can be separated into two groups: 
 

 Market performance goals (sales, profit, market share, etc.) 
 Marketing support goals (awareness, image, education, etc.) 

 
A strategy is the status adopted by a company to achieve its goals. In other words, 
it’s the path followed to achieve a target. 
Strategy development or design is based on two main assumptions: 

 There is more than one way to evolve from one point to another 
 Some roads may be more effective than others 

 
Hence, in a business, there should always be different strategic options, and the 
most convenient one should be selected. 
 
A successful marketing strategy requires the following features: 
 

 Identification and understanding of the customers, suppliers and 
demographic and technological changes. 

 Investigation of flexible and adaptable organization practices 
  To follow the vision/policies that determine the direction of the company 
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 Stimulate the generation of strategic links with other organizations or 
foreign assets (these could be shareholders, customers, suppliers 
orstakeholders) 

 
Action Plan  
An action plan is a diagram showing:  

 The tasks that have to be done 
 In what order 
 By whom 
 Their preferences  
 The dates in which they will be performed 
 Their budget  

 
ASSESMENT AND EVALUATION 
It represents the last step of the marketing plan, and it gives an answer to the 
questions: “How was our performance? How will we measure our developments? 
Where should we make corrections?” Whether the desired objectives are obtained 
from the marketing plan is an important issue. 
The main tool required to accomplish all of the previous is to obtain objective and 
precise information though an appropriate feedback process. 



Introduction to Microsoft PowerPoint
 

What is PowerPoint?
 
PowerPoint 2010 is a visual and graphical application that is primarily used for 
creating presentations. With PowerPoint, you can create, view, and present slide 
shows that combine text, shapes, 
 

 

Find and apply a template (
 
PowerPoint 2010 allows you to apply your own built
templates. It also allows you to search from a variety of templates ava
Office.com. Office.com provides a wide selection of PowerPoint templates known, 
including presentations and slides you design
 
To find a template in PowerPoint 2010, do the following: 
1. On the File tab, click New. 
2. On templates and themes av

 To reuse a template that has been used recently, click 
select the template you want, and then click 

 To use a template that has already been installed, click 
the template you want, and then click 

 To use one of the built
Templates, select the template you want, and then click 

 

Introduction to Microsoft PowerPoint 

What is PowerPoint? 

PowerPoint 2010 is a visual and graphical application that is primarily used for 
creating presentations. With PowerPoint, you can create, view, and present slide 
shows that combine text, shapes, images, graphics, animation, videos and more.

Find and apply a template (Buscar y aplicar una plantilla

PowerPoint 2010 allows you to apply your own built-in templates and custom 
templates. It also allows you to search from a variety of templates ava
Office.com. Office.com provides a wide selection of PowerPoint templates known, 

entations and slides you design 

To find a template in PowerPoint 2010, do the following:  
tab, click New.  

templates and themes available, do one of the following:  
To reuse a template that has been used recently, click Recent Templates
select the template you want, and then click Create.  
To use a template that has already been installed, click My Templates

want, and then click OK 
To use one of the built-in templates with PowerPoint installed, click 

, select the template you want, and then click Create

 

PowerPoint 2010 is a visual and graphical application that is primarily used for 
creating presentations. With PowerPoint, you can create, view, and present slide 

cs, animation, videos and more. 

 

Buscar y aplicar una plantilla) 

in templates and custom 
templates. It also allows you to search from a variety of templates available on 
Office.com. Office.com provides a wide selection of PowerPoint templates known, 

Recent Templates, 

My Templates, select 

in templates with PowerPoint installed, click Sample 
Create.  

 



(You can also search for templates on Office.com from within PowerPoint. In the 
Search Office.com templates, type one or more search terms, and then click the 
arrow button to begin searching.)
 

Create a Presentation
1. Click the File tab, and then click 
2. Do one of the following:

 Click Blank Presentation
 Apply a template or theme, either integrated with PowerPoint 2010 or 

downloaded from Office.com. 
 

 

Open a Presentation
1. Click the File tab, and then click 
2. In the left pane of the Open dialog box, click the drive or folder that contains the 
presentation you want. 
3. In the right pane of the dialog box open, open the folder that contains the 
presentation.  

(You can also search for templates on Office.com from within PowerPoint. In the 
Search Office.com templates, type one or more search terms, and then click the 
arrow button to begin searching.) 

Create a Presentation 
tab, and then click New. 

2. Do one of the following: 
Blank Presentation, and then click Create. 

Apply a template or theme, either integrated with PowerPoint 2010 or 
downloaded from Office.com.  

Open a Presentation 
tab, and then click Open. 

2. In the left pane of the Open dialog box, click the drive or folder that contains the 
 

3. In the right pane of the dialog box open, open the folder that contains the 

 
(You can also search for templates on Office.com from within PowerPoint. In the 
Search Office.com templates, type one or more search terms, and then click the 

Apply a template or theme, either integrated with PowerPoint 2010 or 

 

2. In the left pane of the Open dialog box, click the drive or folder that contains the 

3. In the right pane of the dialog box open, open the folder that contains the 



4. Click on the presentation, and then click 
 

 

Save a Presentation
1. Click the File tab, and then click 
2. In the File name box, type a name for the PowerPoint presentation, and then click 
Save.  
 
Note: By default, PowerPoint 2010 saves files in the file format of PowerPoint 
Presentation (. Pptx). To save the presentation in another format other than. Pptx, 
click the Save as type list, and then select the desired file format
 

 
 
 
 
 
 

4. Click on the presentation, and then click open. 

Save a Presentation 
tab, and then click Save as.  

box, type a name for the PowerPoint presentation, and then click 

By default, PowerPoint 2010 saves files in the file format of PowerPoint 
Presentation (. Pptx). To save the presentation in another format other than. Pptx, 

s type list, and then select the desired file format 

 

box, type a name for the PowerPoint presentation, and then click 

By default, PowerPoint 2010 saves files in the file format of PowerPoint 
Presentation (. Pptx). To save the presentation in another format other than. Pptx, 

 



Insert a new slide 
To insert a new slide in the presentation, do the following:

 In the Slides group on the 
option, and then click the slide layout 

 

 

 
Add shapes to the slide
1. On the Home tab, in the 
2. Click the shape you want, click anywhere on the slide, and then drag to place the 
shape. 
 

To insert a new slide in the presentation, do the following: 
group on the Home tab, click the arrow below the 

option, and then click the slide layout you want. 

Add shapes to the slide 
tab, in the Drawing group, click Shapes. 

Click the shape you want, click anywhere on the slide, and then drag to place the 

tab, click the arrow below the New Slide 

 

Click the shape you want, click anywhere on the slide, and then drag to place the 

 



View a slide show 
To view the presentation in Slide Show view from

 In the Start Slide Show
 
To view the presentation in Slide Show view from the current slide, do the 
following: 

 In the Start Slide Show
Slide. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To view the presentation in Slide Show view from the first slide, do the following:
Start Slide Show group on the Slide Show tab, click From Beginning

To view the presentation in Slide Show view from the current slide, do the 

Start Slide Show group on the Slide Show tab, click From Current 

the first slide, do the following: 
From Beginning 

To view the presentation in Slide Show view from the current slide, do the 

From Current 

 



Print a presentation
1. Click the File tab, and then click 
2. In Print, do one of the following

 To print all slides, click 
 To print only the slide that is currently displayed, click 
 To print specific slides by number, click 

individual slides, a range or both.
Note: Use commas to separate the numbers with no spaces. For example: 1,3,5
 
3. In More Options, click the 
4. Once you have finished your selections, click 
 

 

Tips for creating an effective presentation
Consider the following suggestions to create an attractive presentation to 
your audience interested
 

Reduce the number of 
To communicate a clear message and keep the attention and interest of the public, 
reduce the number of presentation slides to a minimum.
 

Choose a suitable font size for the public

Print a presentation 
tab, and then click Print. 

, do one of the following 
To print all slides, click All 
To print only the slide that is currently displayed, click Current Slide
To print specific slides by number, click Custom range, and then type a list of 
individual slides, a range or both. 

Use commas to separate the numbers with no spaces. For example: 1,3,5

click the Colorand choose the configuration that you want.
Once you have finished your selections, click Print 

Tips for creating an effective presentation 
Consider the following suggestions to create an attractive presentation to 

ed. 

Reduce the number of slides 
To communicate a clear message and keep the attention and interest of the public, 
reduce the number of presentation slides to a minimum. 

Choose a suitable font size for the public 

Current Slide 
, and then type a list of 

Use commas to separate the numbers with no spaces. For example: 1,3,5-12 

ion that you want. 

 

Consider the following suggestions to create an attractive presentation to you’re 

To communicate a clear message and keep the attention and interest of the public, 



Choosing the most appropriate font size helps you communicate the message. 
Remember that the public should be able to read the slides from a distance. In 
general terms, a font size smaller than 30 may be too difficult for the public to see. 
 

Simplify the slide text 
You want your audience to listen while making his presentation, rather than reading 
the screen. Use bullets or short sentences, and try to include all of them in a line, 
that is, without setting the text.  
 
Some slide projectors cut around the edges, so it is possible that long sentences are 
not fully displayed. 
 

Use visuals to help express the message 
Images, graphics and SmartArt graphics provide visual cues for the audience to 
remember. Add meaningful images to complement the text and messages of your 
slides.  
 
However, as with the text, avoid including too many visual aids on the slide. 
 

Create understandable labels for charts and diagrams 
Use only the text that is necessary to the graphics and diagrams.  
 

Apply subtle and consistent slide backgrounds 
Choose a template or attractive and consistent theme that is not too flashy. You do 
not want the background or design to detract from your message.  
 
However, we also want to provide a contrast between the background color and text 
color. The themes embedded in PowerPoint 2010 establishing the contrast between 
a light background with dark text or dark background with light text. 
 

Check the spelling and grammar 
To earn and maintain the respect of the audience, you should always check spelling 
and grammar in the presentation 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
Reference: http://office.microsoft.com/es
basicas-en-powerpoint

http://office.microsoft.com/es-es/powerpoint
powerpoint-2010-HA101824346.aspx 

 

 

es/powerpoint-help/tareas-



11. ITC (Intro to Microsoft Office) 
 
Menú de archivo (File Menu) 
Know the main tools in the File Option:  

 
 

New blank document:This symbol, represents a basic function. This tool is to 
open a new document. This tool can be found in Word, Excel, and Powerpoint. 

Open: This symbol, representsa specific function, to find a document that is 
already saved. 
Close:This function relates to quitting the current document, i.e. leaving the document 
that is open at this time. If you have not saved the changes you have made to the 
document, a message pops up asking if you want to save the changes. But, if the changes 
have already been saved, the document automatically closes when you press “close”. 

Save: This option is for archiving (keeping) your document. Just click on save and 
a window will pop up where you have choices for how to close the document. You name 
the document, choose where you want to save the document, and press ok. If you just 
press save, it will provide an automatic name to the document and it will automatically 
save it to “documents” 

Save as:This option is for you to archive your document. Just click on “Save as” 
and a window will pop up. You choose where to save your document and the name of the 
document and then you press “save”. 
Page Setup:This option is for you to select how you will be presenting the document; 
(horizontally or vertically) margins (bottom, top, left, and right) the sheet size (letter, 
legal, etc.) 



Preview:This option is to be able to view the document in a different way. You 
have several options of percentages, so that you can see the different sizes and choose 
which one works best.  
 

Print: This tool is to help you print the document. Here you can find several 
options concerning the paper size and print options such as: which pages of the document 
you want to print, if you want to print the entire document, if you want to print double-
sided, if you want to print in black and white or in color, etc.. 

Menú de edición (Edit menu) 
Know the main tools in the Edit Option: 

 
 

 

Undo typing:This tool allows us to reverse something we just did. For example, if 
I accidentally deleted something important, I can press the undo typing button and it 
takes back my last action as if it never happened. 

Copy:This tool allows you to copy any part of your document,any other document, 
and anything from the web,then paste it elsewhere. 

Paste:This tool allows you to put the information that you have copied anywhere 
you want in the document 

Cut:This tool allows us to erase all the changes we made to the document that we 
now want to remove. 
 
Select All:This tool allows us to select the contents of the document, either in whole or in 
part, so that we can change some element of the content. For example, we can press 
“Select All” and then change the size, the font (the design of the letters), the color, or 
anything else of the content we selected.  
Note: There are other more complex and less used choices that we will not explain in this 
course. 



Menúver (View Menu) 
Know the main tools in the View Option 

 
 
 
I recommend to people who are not as skilled in Microsoft Word to not use any of the 
other options without supervision from someone knowledgeable and proficient in 
Microsoft Word who can help. Otherwise, any changes made in the document made by 
mistake will not be able to get fixed. 
Note:There are other more complex and less used choices that are not explained in this 
course. Some of these options will vary depending on which program you are working 
with.  

Menúinsertar (Insert Menu) 
Know the main tools in the Insert Option:  



 

Menúformato (Format Menu) 
Know the main tools of the Format Option:  

 



Note: There are oher more complex and less used choices that are not explained in this 
course. Some of these options will vary depending on which program you are working 
with.  
 

Menú de herramientas (Tools Menu) 
THE TOOLS MENU WILL VARY ON EACH OF THE DIFFERENT PROGRAMS. 
EXAMPLES: 
Word 
- Spelling and Grammar Options -Autocorrect- Online collaboration- Spelling and 
Grammar- Language- Word Count- Combine Documents- Combine Correspondence- 
Other tools that we will not mention here. 
Excel 
- Spelling–Autocorrect options-Online collaboration- Customize- Other tools that we will 
not mention here. 
Power Point 
- Spelling–Autocorrect options-Online collaboration- Language–Meeting notes- 
Accessories- Other tools that we will not mention here. 

Siguientesmenús(Next menus) 

 

THE MENU OF TOOLS VARIES IN EACH OF THE DIFFERENT PROGRAMS. 
EXAMPLES: 

Word 
Table Tools Window 
Excel 
Data Tools Window 
Power Point 
Presentation Tools Window 

 
 
 
 
 
 
 



General View of Word, Excel, PowerPoint, and 
WordPad 
 

 

 



 

 
 
 

 
EXCEL 

WHAT IS EXCEL? 
Excel is an application for creating spreadsheets that is divided into rows and columns. 
The space where columns and row cross is called a cell, in which the information is 
stored (letters or numbers) that we can use to perform calculations like additions, 
subtractions, multiplications, divisions, finance operations, statistics operations, 
engineering operations, etc. 



The Window of the Worksheet 

 
 

1. Title Bar: Displays the name of the book and the name of the application… in 
this case Microsoft Excel. For example, when Excel starts the name is 
automatically Book1. 

2. Rows:Each of the horizontal spaces in which a spreadsheet is divided. They are 
identified with numbers. 

3. Columns:Each of the vertical spaces in which a worksheet is divided. They are 
identified with letters. 

4. Sheet tabs:Each book has three Excel 2010 spreadsheets.Every sheet is identified 
by a tab that automatically is named Sheet1, Sheet2 and Sheet3, respectively. We 
can modify those names, as well as add or eliminate sheets. 
 

5. Scroll Bars:It allows to move within the calculus sheet 
6. Active cell:It is the selected cell. Each cell represents a specific position within 

the spreadsheet indicating the intersection of a column and a row. The active cell 
is identified as shown when selected with a double box. 

7. View of the worksheet: There are several different ways to view the worksheets 
in Excel. Each of them works for different situations. Three are in the Viewmenu, 
two are on the Window menu and one more on the File menu. 

8. Zoom tools: Used to increase or decrease the size of what you see on the screen. 



9. Formula Bar: Displays the contents of the active cell. If the contents of that cell 
are obtained from a formula, the formula shows. From here we can also write and 
edit formulas and function. 

10. Ribbon:The Ribbon is designed to help you easily find the necessary commands 
to complete a task. Commands are organized in logical groups that meet in chips. 
Each tab relates to a type of activity (such as writing or laying out a page). To 
reduce clutter, some tabs are shown only when needed. 

11. Name Box: Shows the reference to the active cell, eg A1. From here we can also 
assign custom names to identify the different cells with which we are working. 

12. Selector: If we click the mouse here, the worksheet will be selected as a whole, 
that is, it will be completely selected 

 
Interface Elements 

 
1. Listing File:Opens the Backstage view, which allows us to adminístrate 

documents and their data (create, save, send documents, review documents to 
look if they have hidden metadata or personal information, or establish other 
specific options)  

 
2. Quick Access Toolbar:It’s a personalizable toolbar that contains a number of 

independent commands in a list. 
3. Tabs:Function as general indicators and specific groups containing commands to 

perform certain actions 
4. Control Buttons:Can minimize, maximize, restore or close the application that is 

running. 
5. Control Buttons in the active workbook:Like the control buttons of the window 

in which the application is running, the control buttons of the book allow us to 
minimize, maximize, restore or close the book. 

6. Help:Opens the Microsoft Office Help Page 
7. Control Button Ribbon:It shows or hides the list of options. If the list of options 

is hidden, only the names of the tabs are shown 
8. Logical groups:Within each record, the logical groups are organized grouping 

commands that have similar or related functions. 



Range: Refers to a group of cells. In this sheet, itis the selected range C3: D6.

 
 
 

 
 
 
 
 
 
 
 




